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https://shop.tracks4africa.co.za/product-category/maps/sd-card-maps-maps/

Before you get started, please read here

Important points, all discussed in this document.

Note - the T4A GPS Maps on SD Card:

Is compatible with Garmin GPS Units only
Allows Plug ‘n Play - you are good to go immediately
If your GPS unit does not have an SD Card slot, we do explain how to install the GPS Maps
onto your PC, and then transfer them to your GPS.
The SD Card must be registered with us, you get one free upgrade and subsequent 50%
discounts on gps maps - only on our online store
Take note of a few important settings on your GPS discussed in this document, in order to
make the most of your T4A GPS Maps.
You can install the GPS maps onto your PC for viewing and trip planning - for this you will
require free software from Garmin, namely BaseCamp, Maplinstall or MapSource, all
explained in this document.
o Please make sure that your Operating System is up to date, and if you already have
Garmin Software installed, like Basecamp, Maplnstall or MapSource - make sure its the
latest version please.
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HOW TO USE THIS GUIDE
See how to use the QUICK GUIDE SECTION as your point of reference

See how each step in the QUICK GUIDE SECTION references the DETAILED STEPS IN THE

APPENDIX
QUICK GUIDE SECTION - Start here
1. How to use T4A GPS Maps (On SD CARD) on your Garmin GPS
2. How to install T4A GPS Maps to your PC
3. How to transfer T4A GPS Maps from your PC to your GPS
4. DON'T FORGET
5. HELP with Maplnstall/BaseCamp/MapSource
Some important settings on BASECAMP
6. T4A Videos to help you
APPENDIX - DETAILED STEPS
1. How to use T4A GPS Maps (On SD CARD) on your Garmin GPS
1A) Insert the SD card into your GPS
GPS Units without an SD Card slot:
GPS Units with an SD Card slot: Inserting the SD Card:
1B) Select Only T4A Maps on your GPS
1C) Check these extra settings on your GPS
2. How to install T4A GPS Maps to your PC
2A). More Info on Free Software: Maplnstall / BaseCamp / MapSource
2B). Install the T4A GPS Maps on your PC
2C). Detailed Steps: Viewing the maps via BaseCamp
2D). Detailed Steps: Viewing the maps via MapSource
3. How to transfer T4A GPS Maps from your PC to your GPS
3AA). Uninstall any previous T4A Maps from your GPS
3A). Detailed Steps: Using Maplnstall to transfer T4A Maps to your GPS
3B). Detailed Steps: Using BaseCamp to transfer T4A Maps to your GPS
3C). Detailed Steps: Using MapSource to transfer T4A Maps to your GPS
4. DON'T FORGET TO:
4A). Register your SD Card
Steps on how to register your SD Card:
Have your SD Card packaging handy
Registering your card on our online shop
Help with registering your SD Card
4B) Read about our SD Card GPS Map Releases & Free Upgrades
4C) Check out the T4A Africa Guide on your GPS

©opyrighf TRA CK%FRICA

NG

o o o o M

11

12
13
14
14
14
14
14
15
21
22
22
23
27
29
31
31
35
39
43
48
48
49
49
49
52
52
53



HOW TO USE THIS GUIDE

See how to use the QUICK GUIDE SECTION as your point of
reference

Start by referencing the Quick Guide Section:

QUICK GUIDE SECTION - Start here
1. How to use T4A GPS Maps on your Garmin GPS
2. How to install T4A GPS Maps to your PC
3. How to transfer T4A GPS Maps from your PC to your GP3
4. DON'T FORGET
5. HELP with Maplinstall/BaseCamp/MapSource
Some important settings on BASECAMP

0O o w o O O N

—_—

See how each step in the QUICK GUIDE SECTION references the
DETAILED STEPS IN THE APPENDIX

—p QUICK GUIDE SECTION - Start here 6
1. How to use T4A GPS Maps on your Garmin GPS® 6

2. How to install T4A GPS Maps to your PC 6

3. How to transfer T4A GPS Maps from your PC to your GPS 8

4. DON'T FORGET 9

5. HELP with MapInstall/BaseCamp/MapSource 10
Some important settings on BASECAMP 10
APPENDIX - DETAILED STEPS 12
1. How to use T4A GPS Maps on your Garmin GP3S ' * 12
1A) Insert the SD card into your GPS 12

GPS3 Units without an SD Card slot: 12

GPS Units with an SD Card slot: Inserting the SD Card: Detailed Steps 12

1B) Select Only T4A Maps on your GP3 13

1C) Check these extra settings on your GPS 17

2. How to install T4A GPS Maps to your PC 18
2A). More Info on Free Software: Mapinstall / BaseCamp / MapSource 18
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QUICK GUIDE SECTION - Start here

1. How to use T4A GPS Maps on your Garmin GPS

Follow the Summary steps
and information under
"Summary", from Step A
to Step B etc. if you are
familiar with our processes.

Step Summary See Detailed Steps Here
Step A | Insert the SD card into your GPS See Appendix ltem 1A for
more info
Step B | Go to map settings and select only the T4A See Appendix Item 1B for
maps. Do not select more than one type of more info
map at a time.
Step C | Check these extra settings on your GPS: See Appendix Item 1C for
e Set preference to Fastest Time / Fastest Route more info
«  Switch off Avoidances
« Set Map detail to more.

2. How to install T4A GPS Maps to your PC
Why would you want to do this?

e [f you want to view your T4A GPS Maps on your PC, which will enable you to plan trips
etc.

If you require more information

and help - go to each Appendix

Item per Step for more details
and screenshots.

Also note, that if you do reference the Appendix, please be sure to follow the links to “Go
Back to Quick Guide section” - don'’t just continue into the next Appendix section - it may

confuse you.

Example - Using the Micro SD Card in a Garmin Unit:
Extract the micro SD card from the adapter, and only insert the micro SD card
into the Garmin GPS Unit.

Go Back to Quick Guide section +

Okay, let’s get started!

©pprright TRACK4ﬂFRICA



QUICK GUIDE SECTION - Start here

1. How to use T4A GPS Maps (On SD CARD) on your Garmin GPS

Step Summary Steps See Detailed
Steps Here

YouTube

Step A | Insert the SD card into your GPS See Appendix Video not available
Iltem 1A for more
info & images

Step B | Go to map settings and select only the T4A See Appendix Video not available
maps. Do not select more than one type of ltem 1B for more

map at a time. info & images

Step C | Check these extra settings on your GPS: See Appendix Setting up your
e Set preference to Fastest Time / Fastest Route Item 1C for more GPS
e Switch off Avoidances info .
e Set Map detail to more TRACK#AFR'CA B Windoue
e Ensure only the T4A Map is selected on your GPS u
e Look at our YouTube video “Setting up your GPS”

YouTube

2. How to install T4A GPS Maps to your PC

Why would you want to do this?
e |f you want to view your T4A GPS Maps on your PC, which will enable you to plan trips etc.
e You have an older GPS unit which does not accept a Plug & Play SD card, you will need to
install T4A GPS Maps on your computer and transfer the maps to your GPS.

©pprright TRACK4ﬂFRICA


https://www.youtube.com/channel/UC5xUnkKwjbBvPQeDYdFBOLA/featured
https://www.youtube.com/channel/UC5xUnkKwjbBvPQeDYdFBOLA
https://youtu.be/HIuJlkeDHMI
https://youtu.be/HIuJlkeDHMI
https://youtu.be/HIuJlkeDHMI
https://youtu.be/HIuJlkeDHMI

Step

Step A

Summary Steps

Install Free Software: MaplInstall / BaseCamp /
MapSource:

See Detailed
Steps Here

See Appendix
Item 2A for more
info on this
software, and to
help you decide
which one to
install.

YouTube

See videos below

BaseCamp:
(Recommended)

View the T4A GPS maps, plan trips etc. and transfer &
receive maps, waypoints etc. to and from a GPS unit. (ie.
the Maplnstall function resides within BaseCamp too)

Click here to download Garmin BaseCamp for free

and then install it on your PC.

Install

BaseCamp on
Windows

TRACK#‘AFRICA £ Windows

YouTube

OR MapSource:
(Older software, more popular than Basecamp)

Please note: Before installing MapSource, you will have
to install BaseCamp, otherwise the MapSource
installation won’t work.

MapSource allows you to view the T4A GPS maps, plan
trips etc. MapSource can transfer & receive maps,
waypoints etc. to and from most Garmin GPS units -
the Garmin Drive GPS units don’t always work with
Mapsource.

Click | lownload Garmin MapS for f

and then install it on your PC.
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https://www.youtube.com/channel/UC5xUnkKwjbBvPQeDYdFBOLA
https://www8.garmin.com/support/download_details.jsp?id=4435
https://youtu.be/69CGmmZeXDA
https://youtu.be/69CGmmZeXDA
https://youtu.be/69CGmmZeXDA
https://youtu.be/69CGmmZeXDA
https://www8.garmin.com/support/download_details.jsp?id=209
https://www8.garmin.com/support/download_details.jsp?id=209

GARMIN,

AND/OR Maplnstall:

Note that “Maplnstall” is a feature incorporated in
BaseCamp. One can also download and install
Maplnstall separately, which purely transfers the GPS
maps to your GPS Garmin Unit. You cannot view the
GPS maps or do trip planning etc. in Maplnstall.

Click here to download Maplnstall for free

and then install it on your PC.

Install Maplnstall
on Windows

TRACK41FRICA £ Windows

YouTube

Step B | Read the SD card with your PC and go to the PC | See Appendix
Install Files folder on the SD card, and run the !tefm_ZB for more
EXE file to install the T4A GPS Maps onto your 1nio
PC.

Step C [ Open and View the installed T4A GPS Maps on

your PC, using:

GARPMIN.

*Note: You cannot access and view the maps via
Maplnstall - that is purely used to transfer the maps
from your PC to your GPS Unit.

BaseCamp:
See Appendix
Summary Steps: Item 2C for more
e Open BaseCamp info
e In Menu: Maps (ie. select the maps you installed &
want to view)
OR
See Appendix
MapSource: Item 2D for more
info
Summary Steps:

e In Menu > Switch to product (ie. to select map to
you installed & want to view)
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https://www8.garmin.com/support/download_details.jsp?id=3291
https://youtu.be/HFS5MhvlXrg
https://youtu.be/HFS5MhvlXrg
https://youtu.be/HFS5MhvlXrg
https://www8.garmin.com/support/download_details.jsp?id=209

Install T4A Maps on Windows (From

Steps A to C above are available on our

Youtube channel. We suggest you go through E—
the steps above first as there is some software TRACK 41FRICA P o
you will need to install first that is mentioned in )

this video. n

YouTube

3. How to transfer T4A GPS Maps from your PC to your GPS

Why would you want to do this?
e You have an older GPS units which does not accept a Plug & Play SD card, you have installed
the T4A GPS Maps to your PC as per the previous section number 2, and now you want to
transfer the maps to your GPS.

Step Summary See Detailed
Steps Here

YouTube

First: Connect your Garmin GPS Unit to your PC via

USB cable.
Uninstall any previous T4A GPS Maps from See Appendix
your GPS unit. Item 3AA for

more info

Step A | Open Maplnstall / BaseCamp / MapSource that
you installed, and transfer the maps to your
GPS.
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https://youtu.be/SDO59GIp0ps
https://youtu.be/SDO59GIp0ps
https://youtu.be/SDO59GIp0ps
https://www.youtube.com/channel/UC5xUnkKwjbBvPQeDYdFBOLA

GARMIN,

Via Maplnstall: (recommended option)

Summary Steps:
e Find Device

Choose device to install maps on (ie. internal GPS
memory or SD Card)
e Click ‘Customize’
e Select maps to transfer
e Click ‘Continue’
o C(Click ‘Install’
e Click ‘Finish’

See Appendix
Item 3A for more

info

Transfer T4A

Maps to GPS
using Windows

TRACK41FRICA £ Windows

YouTube

OR via BaseCamp:

See Video above on
how to use the

See Appendix .
Summary Steps: Item 3B for more M?plnstall function
e Menu: Maps > Install Maps (ie. will initiate built-in info with Basecamp fo
Maplnstall function) transfer the maps.
e Find Device
e Choose device to install maps on (ie. internal GPS
memory or SD Card)
e Click ‘Customize’
e Select maps to transfer
e Click ‘Continue’
e Click ‘Install’
e Click ‘Finish’
OR via MapSource: See Appendix
Item 3C for more
info

IMPORTANT TO NOTE: MapSource can
transfer & receive maps, waypoints etc. to
and from most Garmin GPS units - the
Garmin Drive GPS units don’t always work
with Mapsource.

Summary Steps:
In Menu > Switch to product (ie. to select map to

transfer to GPS unit)
Then: Tools > Map (ie. this is the Map Tool used to
select maps on the screen - maps will turn pink when
clicked on))

<

® Use Map Tool to select one or more maps.
e  Only the pink selected map areas will
transfer to your GPS
e Then: Menu > Transfer

©pprright TRACK4ﬂFRICA
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https://youtu.be/yRIz64qYABM
https://youtu.be/yRIz64qYABM
https://youtu.be/yRIz64qYABM
https://youtu.be/yRIz64qYABM
https://www8.garmin.com/support/download_details.jsp?id=209

e Choose device to install maps on (ie. internal

e Send to Device
e Find Device

GPS memory or SD Card)
Ensure ‘Maps’ is ticked
e Click ‘Send’

4. DON’T FORGET

Ensure your SD Card is
registered

In order to qualify for your free
upgrade and subsequent
discounts on our online shop
only!

See Appendix Item 4A for more
info

See How to register your SD
Card on YouTube:

YouTube

Read about our Free SD Card
Upgrade Policy and discounts

See Appendix Item 4B for more
info

See this YouTube video for more

info:

YouTube

Check out the T4A Africa
Guide on your T4A GPS Maps
SD Card

See Appendix Item 4C for more

info

©opyrighf TRA CK%FRICA
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https://shop.tracks4africa.co.za/register-sd-card/
https://shop.tracks4africa.co.za/register-sd-card/
https://youtu.be/bI2e8eI3oLM
https://youtu.be/bI2e8eI3oLM
https://youtu.be/bI2e8eI3oLM
https://youtu.be/A1F8WAWsUbM
https://youtu.be/A1F8WAWsUbM
https://youtu.be/A1F8WAWsUbM

5. HELP with Maplnstall/BaseCamp/MapSource

For more information on how to use BaseCamp, please refer to Garmin’s help tutorials which can be
find on their website. At time of this publication this information was available from the internet location
below:

https://support.garmin.com/en-US/?productiD=52801&tab=topics

Some important settings on BASECAMP

Make sure your settings on Basecamp is the same as the settings on your GPS else you will get
different results if transferring routes from Basecamp to your GPS unit.

In order to view and see POls (ie. Lodges, campsites, restaurants etc.) on your screen - make sure that
your Map Detail is set to Highest.
1. Open Basecamp - Go to top main menu - click on “View”, then “Toolbars” and then make sure
“Detail Level” is ticked. See number 1 below.
2. You will notice a small block pop-up on your screen - make sure you choose “Highest” from that
drop-down list of options.

2

@ Garmin BaseCz/np
File Edit Device Find | View | Tools Maps Trip Planner Adventures BirdsEye Signln Help

Highest v] @ 1} & Basic Map Only Ctrl+G i % @ o UL B ﬁ Driving =
4 Library Align North Up Ctrl+N
Egr?::ﬁit:’;ms POIs Data lter g
- [3) NewList 2l SortBy 3
[ Unlisted Data &5  Swap Map and Data Views Ctrl+Tab :%}5
‘ %ﬁrmm Ac.iven.tures & Full Screen F11
¥ What is this? )
Map Views 3
Map Controls 3 1
| Toolbars v [[“] Activity Profiles /
B, Selected Items on Map Ctrl+D | Detail Level r|
& Google Earth v || Device Transfer
|| Drawing Tools
[¥] Edit
Playback
Playback Info
My Collection F Map Products
A Klein-Aus Vista Campsite (Gond Z| Map Tools
ﬁAmﬁnzi River Camp (Abiqua) Se Z| View
@ Aus
. Aussenkehr

©pprright TRACK4ﬂFRICA
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https://support.garmin.com/en-US/?productID=52801&tab=topics

6. T4A Videos to help you

Find Videos: On our Youtube Channel.
For Trip Planning - see this playlist:
e BaseCamp Basics Full Tutorial - A detailed tutorial on basics of BaseCamp & Tracks4africa

Maps

e MapSource Basics FULL Tutorial - A detailed tutorial on basics of MapSource & Tracks4africa
Maps

e Setting Up Your GPS

©pprright TRACK4ﬂFRICA
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https://www.youtube.com/channel/UC5xUnkKwjbBvPQeDYdFBOLA
https://www.youtube.com/playlist?list=PLj_Vo0u6SMmwXv5IrjgxcXu0-D0NFdIrh
https://youtu.be/QLD34QW0NWQ
https://youtu.be/9_s302SRAFI
https://youtu.be/HIuJlkeDHMI

APPENDIX - DETAILED STEPS

1. How to use T4A GPS Maps (On SD CARD) on your Garmin
GPS

1A) Insert the SD card into your GPS

T4A GPS Maps are distributed on a Plug & Play SD card. This is an SD card with T4A GPS
Maps preloaded and ready to use in your compatible Garmin GPS.

For older GPS units which do not accept a Plug & Play SD card, you will need to install
T4A GPS Maps on your computer and transfer the maps to your GPS, using BaseCamp
or Maplnstall.

These are all applications provided by Garmin. (Note: This free software is discussed
further in this document namely “How fo install T4A GPS Maps to your PC”)

If you have a GPS which was manufactured in 2011 or later then you are advised to
use the latest version of Maplnstall to transfer maps from your Mac or PC to your GPS.

Examples of older units that do not use an SD card are 276¢, 76¢ and 60c.

Please contact our sales office to assist you in this regard: sales@tracks4africa.co.za

Switch off your GPS, remove any existing SD cards (keep in safe place).

Insert the T4A GPS Maps SD card. Use either the Micro SD card plus Standard adapter

or the Micro SD card depending on what type of SD card reader you have on your GPS.

©pprright TRACK4%FRICA
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Micro SD card plus
Standard adapter

Micro SD Card

Example - Using the Micro SD Card in a Garmin Unit:
Extract the micro SD card from the adapter, and only insert the micro SD card into the
Garmin GPS Unit.

YouT Vi . How to remove small SD Card from Big SD Car I,

Back ick Gui ion

1B) Select Only T4A Maps on your GPS

Switch on your GPS then:

You may see the message as per below appear - choose "NO".

©opyrighf TRA CK%FRICA
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https://youtu.be/pM3rLuvOr8s

New Extras cjata found on card.
install this data to make it available if the
card is removed?

e
Yes

__Settings

This means that the Garmin unit has picked up that there is an extra data file on the SD Card. In
this case it has picked up on the Africa Guide, that is supplied by T4A, and included on our SD
Cards. It is not necessary to install this onto your GPS unit, as you can access it directly from
the SD Card. This file is about 30MB in size. See Appendix Item 4C for more info on the Africa
Guide.

You have to enable the T4A GPS Maps on your Garmin Device: If you have Street
Navigation Maps on your unit on the internal memory, you cannot run T4A GPS Maps and
your street maps at the same time. Please be sure to only select T4A GPS Maps if you want
your unit to navigate you from our maps, or vice versa. (ie. Never use any two map products for
the same area at the same time as it may result in conflicts. Simply select which one you need
and switch the other off).

Depending on what GPS unit you have, the setting will differ from GPS range to GPS range. Itis
usually under the “Settings” and then “Mapinfo” on your GPS unit. For Nuvi and Zumo units, this
can be found by clicking on the ‘spanner’ (Tools). Then select Settings>Map>Maplinfo to get to
the screen where map selection is made.

If you have any previous versions of T4A GPS Maps installed on your GPS’s internal memory
you will need to remove those maps.

©opyrighf TRA CK%FRICA
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& T4A Traveller's Africa 171001

M TAr 100 e

| CN Southern Africa NT 2013.30

See more examples of how to enable this setting on:
e The newer Garmin Nuvi range
e Garmin Montana range

Steps on the newer Garmin Nuvi range: (Please note that the older Garmin Nuvi range will
work differently to the newer units)

e Switch on your GPS and select Settings on the home page.

3 13:22

Where To?
) W
Volume Apps Settings

Then select Map & Vehicle on the next page.

©opyrighf TRA CK%FRICA
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| All Settings |
Map & Vehicle

Map, vehicle and dashboard options

Navigation
Sets route preferences

< Display
Brightness, colour mode, timeout

4_) Bluetooth

Connects to a Bluetooth phone

On the next page, scroll down and select myMaps. All your installed GPS Maps will be listed
here.

Map & Vehicle [y
a 2

Auto Zoom —
Disabled

myMaps

Installed maps

Related ltems

Navigation
Sets route preferences

y €

Enable the map you wish to use on your GPS by selecting the tick box. Remember that you
may only have one map product enabled (ticked) otherwise the GPS won't know which map to
use and will give navigation errors.

T4A Maps 1405.01
T4A 140501 Travellers Africa Swaziland,
T4A Mozamb
~ CN Southern Africa NT
2015.10 ALL

©pprright TRACK#%FRICA
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Steps on the Garmin Montana range:
e On the homepage of the GPS, click on the arrow on the left-hand side of the screen.

TG, Y

Friday
August 15

Compass Mark
Waypoint

e Select Setup on the next page

Computer

b ™

Elevation 3D View
Plot Viewer

PR 1-_\\_ J.

* Geocaching Share Profile
Wirelessly Change

e Then select Map.

e Click on Map Information and then Select Map.

©opyrighf TRA CK%FRICA
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Orientation Guidce -
Dashboard - :
_
1 Map Speed
> e

Click on the map you wish to enable on your GPS device.

L @ Enabled - T4A Maps _Traveller's Africa 14.05.01

T4A Maps 1405.01

‘b Disabled - Garmap SSA Streetmaps 2013.1 NT

Garmap SSA Streetmaps 2013.1 NT

Disabled - USGS Quads

,b Grand Canyon National Park JNX

Select Enable in order to have the GPS map of your choice enabled. Remember that you may

only have one map product enabled otherwise the GPS will give navigation errors.

Enabled - T4A Maps _Traveller's Africa
14.05.01

e |

o

Go Back to Quick Guide section

©pprright TRACK4ﬂFRICA
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1C) Check these extra settings on your GPS

Here are a few tips to get the most out of your T4A GPS Maps on your GPS:

Switch on your GPS then check: (please note the options available on the GPS units may differ
between various models)

1. Route preference: Route Calculation should be set to:
e Fastest Time / Fastest Route / Minimise Time
o The GPS will take you on the fastest routes such as main gravel or tar, rather
than on 4x4 tracks, two-spoor etc.
o Note that the fastest time may not necessarily be the shortest distance

e Shortest Time / Shortest Route / Minimise distance
o The GPS will then always pick the shortest route, which will often include 4x4
tracks, two-spoor etc.
o Note that the shortest distance, over 4x4 tracks, may take longer to complete
than a "fastest time" route, which may be longer but faster to drive.

e Off Road

o Take care here! Off road assumes that there are NO roads here, and draws a
straight line from your position, to your destination. So it won't navigate along
existing tracks. If you choose this option, and you see tracks, you can then just
keep following them as you physically see in front of you, and make up your own
mind which ones you want to use. It will require a lot more user decision making
on your part. But it won't warn you that there may be a dead end, or if there is no
connecting road to your destination.

2. Route preference: Avoidances, should all be switched off ie. unticked

e Toll Roads: one can tick this one, and the GPS will keep you off highways with toll
roads!

e Unpaved Roads: If you want to go on gravel roads, this must be UNticked - remember
the ones you tick, are the ones the GPS will avoid. So you tick toll roads, so the GPS will
avoid toll roads. But UNtick unpaved roads, as you WANT to travel on gravel. Keep in
mind your GPS will start looking for the shortest route as soon as you leave your
destination, so you may want to toggle your Fastest Time and Avoidances settings as
you travel, depending on what you want to do.

e Butitis not always an exact science - if you "select to avoid tolls or highways”, the GPS
will select the best route and try to avoid tolls and highways as far as possible, but you
may still travel through a toll or a highway if it is a more sensible route than avoiding it...

©opyrighf TRA CK%FRICA
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*Note on Shortest Route & Unpaved Roads: If you are using these settings, your GPS will always
look for the SHORTEST route, regardless if it is tar or gravel, it will take you on the shortest route. If you
tick "unpaved roads", you are telling the GPS to avoid “unpaved roads”, and if you tell it to use shortest
route, it will take you the shortest route on tar only. If you tick "toll roads" and use shortest route, it will
avoid toll gates (but it will not avoid other tar roads).

*Note if you specifically want to travel backroads: Best practise is to tick Shortest Distance and
untick ALL avoidances but always apply some brainpower too, check which routing the gps follows,
don't just religiously follow the GPS.

3. Map Detail: Should be set to “More” or “Most”

4. Make sure that the Tracks4Africa map is the only map selected under your My Maps settings (see

1B) Select Only T4A Maps on your GPS)
See this informative video from Garmin: Navigational Avoidances on Garmin Automotive Devices

Make sure your settings on Basecamp/Mapsource is the same as the settings on your GPS else you
will get different results if transferring routes/waypoints from Basecamp/Mapsource to your GPS unit.

We do recommend that you plan your route on a computer where it is easier to see the gravel roads on
Basecamp/Mapsource, and then send those POI's/Waypoints to the GPS and follow the
POl's/Waypoints.

It is essential that you create waypoints, and use the waypoints to create the route, and NOT use the
routing tool in Mapsource/Basecamp to create the route, as we have encountered problems transferring
the route created with the routing tool to the GPS, often it will not recalculate on the GPS.

*POI/Waypoint (Is a Point of Interest like a campsite, fuel stop, restaurant etc)

Go Back to Quick Guide section

2. How to install T4A GPS Maps to your PC

2A). More Info on Free Software Maplnstall / BaseCamp | MapSource

Garmin offers three seperate FREE map viewing software options:

e BaseCamp: One can view the T4A GPS maps on this platform, plan trips, transfer &
receive maps, waypoints etc. to and from a GPS unit.

©pprright TRACK4%FRICA

22


https://support.garmin.com/en-ZA/?faq=coS9eU8aTM8s443zB7jPM8

e MapSource: One can view the T4A GPS maps on these platforms, plan trips etc. Note -
To transfer & receive maps, waypoints etc. to and from a GPS unit is only possible in
MapSource with T4A GPS maps versions 18.05 and older.

e Maplnstall. Which can only transfer maps to your GPS unit. Note that Maplnstall is a
feature incorporated into BaseCamp too. It can also be installed and used as a stand
alone product to transfer maps to your GPS unit.

You can choose to use any of the software, many people prefer MapSource as it is easier to
use, although BaseCamp is the newer software, and MapSource may eventually be phased out.
e Please note however: Before installing MapSource, you will have to install BaseCamp,
otherwise the MapSource installation won'’t work.

e The T4A maps from version 18.10 onwards, can only be installed to Garmin Devices
using_BaseCamp and Maplnstall. MapSource will only work up to T4A maps version
18.05. You can therefore not use Mapsource to install maps to your GPS unit for our
latest maps - but you can still use it for trip planning, and then use Maplnstall to transfer
maps to your GPS unit.

The download links are provided in Section 2 was correct at time of publication. If you are
unsure where to find these downloads, do a Google search for “Garmin BaseCamp” or “Garmin
MapSource”.

For more information on how to use BaseCamp, please refer to Garmin’s help tutorials which
can be find on their website. At time of this publication this information was available from the
internet location below:

https://support.garmin.com/en-US/?product|D=52801&tab=topics

Go Back to Quick Guide section

2B). Install the T4A GPS Maps on your PC

1. On the SD card there are install files for your PC. Insert the SD card into an SD card
reader. Some GPS units, digital cameras and mobile phones can be used as SD Card
readers when connected to your PC via USB cable. The best option would be to use a
dedicated SD card reader if your PC does not already have one.

In this example, the Garmin GPS unit (with SD card inserted) is connected to the PC via
USB cable.
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2. Use Windows Explorer to browse the contents of the SD card, look in the folder called

“PC Install Files”. You will find the installation file in this folder.

< | USE Drive ()

y N -y 7 8 - I - f
B A & cut 4 =) x __p 1 New item Bl e Open~ [ selectall
=l W= Copy path £ Easy access = Edit Select none
Pinto Quick Copy Paste _ Move Copy Delete Rename  New Properties =
s ] Paste shortcut | ton o gl S @ mistory 2 invert selection
Clipboard Organize New Open Select
&€ 3 v 4 > USBDrive(G)
Wi A Name Date modified Type Size
Documents 19-Sep-17 8144 File folder
I ThisPC ’ '
Garmin 1 File folder
IS0 Jojects Mac Install Files 19-5ep- File folder
I Desktop PC Install Fi 1 File folder
%] Documents \
Downloads " Soen
b4 2. Open the "PC Install Files
Music
$ folder here.
&= Pictures
B Videos
= 05(C)

A Garmin nivi (E)

s USB Drive (G)

=R network (\T4Asn 1) (V)

= Janine (\T4Asn02\Backup) (Z:)

1. On your PC, you will see, similar to
A Gamin oo 6% this, your Garmin Internal memory
— USB Drive (G 4%nd the SD card (USB Drive connection)

Documents here.
Garmin

Mac Install Files

PC Install Files

ditems  1item selected

v O

Search USB Drive (G:

3. Select for example, T4A GPS Maps_Travellers Africa_1710.exe and run it (ie. double

click on the exe file).
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I [4 ] = | PC Install Files HoX

Home  Share  View (7]
e x ¥ [T New item = El Open - F selectall
- A £ Easyaceess = Edit 12 select none
Pinto Quick Copy Pas v Copy Delete Rename  New Properties
SSSSSS to = falies s ©History g7 Invert selection
Clipboard Organize New Open Select
= v 4 || > USBDrive(G) » PClnstall Files ~|@ | Search PC Install Files »
& OneDrive A Name - Date modified Type Size
1 i P JF T4A GPS Maps_Travellers Africa_1710.exe  03-Sep-176:36 M Application 246,346 KB
B 3D Objects
B Desitop T4A GPS Maps Installation file
[£] Documents
& Downloads
D Music
[&] Pictures.
B Videos
i 05(C) [
A Garmin novi (E)

== USB Drive (G)
=& network (\T4Asn01) (¥:)
=% Janine (\T4Asrn02\Backup) (Z:)

A Garmin nivi (E)

s USB Drive (G
Decuments
Garmin
Mac Instzll Files
PC Install Files

f BreLOiRES

4. Follow the instructions on the install wizard:

Please Note: If your PC gives you a warning that the file you are about to run will
put your PC at risk - please do not be concerned - click on the link “More Info”:

Windows protected your PC

Jefender SrartScreen pr d an unrecagnized app from
Running this app might put your PC at risk.
More info

Then click on “Run anyway”.

If this is not available - take note that your firewall could be preventing you from
running the file: Go to Windows Security/Windows Defender to fix the problem:
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To fix the problem, open Windows Defender and go to
App & Browser Control. Under 'Check apps and files',
select the 'Warn® option instead of the 'Block’ option.
When you next encounter the SmartScreen, click the
See more option. This will reveal the Run Anyway
button that you can click to run the app in question.

Windows protected your PC

ized app from

The installation process will start - follow the on-screen instructions.
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2 0= ApplictionTools  PC Install

C Install Files — o X

ol
4 cut B New item ~ » open~ | Fsetectalt I
B Eis, BE XS - e
= = Copy path easyaccess = at S
PintoQuick Copy Paste Move Copy  Delete Rename  Mew Praperties
Oeedm | B2 &7 52 o) EES o vistory | B inwert selection
Clipboard Organize New Open Select
<« © &[> USBDrive(G) > PC Instal Files v[0] | Search PC Instal Files »
. Map 17.10 Setup - x
@ OneDrive Name "
I = ThispC E T4A GPS May Welcome to T4A Traveller's Africa
= Map 17.10 Setup
3 30 Objects

I Desktop

 you through the instalaton of T4
7.10,

A\ Gamin novi (E)

= USB Drive (6)

= network (\T4Asn01) (V:)

= Janine (\T4Asr02\Backup) (Z)

A\ Garmin nivi (E)

s USB Drive (G

Documents

Mac Install iles
PC Install Fles

Titem 1 item selected 240 MB

A BreLiRe@EEL DS

When done, click “Finish”, then Exit.
Now T4A GPS Maps are installed on your PC.

Go Back to Quick Guid .

2C). Detailed Steps: Viewing the maps via BaseCamp

Firstly, you need to open BaseCamp.

Double-click on the
Basecamp Icon to open
Basecamp.

This is an example on Windows 10
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BaseCamp will open up.

@ Garmin BaseCamp - x
File Edit Device Find View Tools Maps TripPlanner Adventures BirdsEye  Signln  Help Search -B
R X ‘ n & o, -
pmx 9t b (B AR%Y O % B § - ¢
¥} BaseCamp found some new tracks on your niivi 42 . Click here for options. 2 %

S| LEC NEW POINTS_ANGOLA  ~
=] LEC NEWPOINTS_BOTSW
LEC NEWPOINTS_EAST_A

LEC NEWPOINTS_EASTER [ A
E15m33

LEC NEWPOINTS_GAUTEN

i, /
TS ST

[
T
%

LEC NEW/ POINTS_LESOTHO - Davenis Farm

LEC NEWPOINTS_MADAG =

LEC NEWPOINTS_MOCAM =

LEC NEWPOINTS_NAMIBIA ] ) =
LEC NEWPOINTS_NORTH_ » %

LEC NEWPOINTS_NORTH_
LEC NEWPOINTS_SWAZIL = 3
= . .. S A v ) \
LEC NEW POINTS_WEST_NORTH_Cape.g... ¢ 5

 Kiyane

Maleshe,

@-

Closed (Engen Fuel Stzp (Doring Bey))  * [y |w
Engen Fuel Stop (George)

. ¢ i Bl 4o

Fuel Stop (Kakamas) a . s - * - '@Tsab
= .

B Total Fuel Stop (Nossob) (07 : 4Logagar
) Total Fuel Stop (Hossok) (07:20-18:00) D611 .

- . . (0615 o v f

{4 Closed (Millers Restaurany =

. H
(B Cios= (Sanvich Barcn Resteursni- St . . - » GobdHops
4] Fishivays 3
) Salrstrip (Twee Rivieren Airstrip) 1.9km
. .
Steers Fish-Aways (Oudtshoorn) 4 “Teans Teane . Khotswane
A . S =
* Amani Boutique Hotel g v Mciom
* Amazian Lodge
. .
* Amble Inn Guest House Lbuibs ity 2 + Struizendam .
a ‘ . Middelplits
» itz Private Lodge & B38 M @ic= e . (Grosb ey Sroot Mier s Hligdct? .
(e b oPhilafdersbron

Search B J Ds10) - = =]

ENG 11:20AM
US  D6-Mar-18 Ez

CLORVERE 1 T Q) B

The Maps item in the menu will list

@ Garmin BaseCamp - X
File Edit Device Find View Tools | Maps | TripPlanner Adventures BirdsEye Signin  Help a " m apS |nsta "ed on you r GRC . -HB
G2 X 9 O g g [ @ ete T4 Maps Westend North Cope 17.05.02 o 2
: I s o it Select the T4A GPS Maps in order
@) BaseCamp found some new tracks on your niivi 42 - 2 X
4 obal Map = A Z e
[E] LEC NEWPOINTS_ANGOLA A L — = ito V_IeW Iton you&arb- / l
LEC NEWPOINTS_BOTSW « —Liy il
% LEC NEWPOINTS_EAST_A T44 Maps Ethiopia Sudan Eqypt 170501 el /’\/' Uy BRI (5]
NE _EAST_A ]
[E] tec NEwPOINTS EASTER 4A Naps [esatha 170501 = L) l
- i o ssob Airstrip (1.Gkm) 1
5] LEC NEWPQINTS GAUTEN T4A Maps Madagascar Mauritius 170501 o 5 é
X J n
2] LEC NEW POINTS_LESOTHO T4A Maps Morocco Westem Sahara 170501 /s'
2] LEC nEwPOMTS MaDAG T4A Maps Mozambique Malawi 170501 * . 5
2] LEC NEWPOINTS MOCAM. TAA Maps Swaziland 170501 1Gemelodop At S RE 2
[2] LEC NEWFOINTS NamiBIA [#] T34 Traveller's Africa 171001 o [y kNababiess 7 B
[5] Lec nEwPOINTS_NORTH_ P— \@@“ ;”Wwaue;
[2] LEC NEWPOINTS_NORTH_ i faicl il ol SN L
[B) Lec newroINTS SwaAzIL. thskaltMaps 4,5/ =
e Manage Map Products... f  Kivand
LEC NEW POINTS WEST_NORTH Cape.g...
g Manage Custom PO | Maleshe,
Closed (Engen Fuel Stop (Dering Bay)) || [ U . s
Engen Fuel Stop (G 3 5 [S] » =3
ngen Fuel Stop (George) < - L o o

) Fuel Stop iKakemas) O R ~ - . 2 i
s . <
) Total Fuel Stop (Nossab) (07:30-18:00) D611 . *\ L JLogagar
: . . 10613 o f 0

Closed (Miller's Restaurant)

2 . 1] L ~
Closed (Sandwich Baron Restaurant - St = b . gg\.' , Gobd Hope }r/
[ Fisn-vays g & ol B217]

Steers Fish-Awiays (Qudishoorn) % = et [T‘"Befs‘ :::T"S::Z'”p) L Khotswane
A 5 :
s Amani Boutique Hotel - i (GG FHelkom
L C11/D614 e
s Amazian Lodge C1aM 27
» - %
® /Amble Inn Guest House . Lotibs City A  Struizendarn
. . _

» Amritz Private Lodge & B&E ~ e o G)’“’Eb M e, Groot Mla: 2
Sear i  Philahdersbron
Search - g =50 B - <

ENG 11:22 AM

B S C o= AP g g & tLORS BoEamooE 0 S B

Go Back to Quick Guide section

©opyrighf TRA CK%FRICA

28



2D). Detailed Steps: Viewing the maps via MapSource

Firstly, you need to open MapSource.

@

L -

&

-y My -

Double-click on the
Mapsource lcon to open
Mapsource.

@-Qﬂa

This is an example on Windows 10

MapSource will open up.

B Lirstbed - bagfowon
Fie Bt Pl Tnste View Took Liies Hel
TR Bt Mg Full 16 1080 - I Madn i d QD Pk =

Vacu  Wayports Fsutes Trace

e ] S

You are now ready to use
Mapsource, and to view the
Tracks4Africa GPS maps in

Mapsource.

3 M) -0 K2

Mg Sal Mar

1 bowrrs Cabocted Lab/Lan hubshd marn men e (G5 B4

i om AR B P RAT F D ® ¥ ® LEsve e T B

To view the Map/s in Garmin MapSource go to View > Switch to Product and
select the T4A Map you would like to view.
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P8 Untitled - MapSource
File Edit Find Teansfer | View

T4A Beta Maps Full 16.10.03

Maps  Waypoints Routes

show waypoints in category:
All Categories

Name 7

Tools Utilities Help
Show Selected Item On Map

Go To Position.

ZoomIn
Zoom Out

Zoom In Max
Zoom Out Region
Basic Map Only
Shouw Crosshair
Hide MiniMap
Switch to Product
Change Map Scale
Map Detail

Shouw Toolbars
Hide Status Bar
Hide User Data Tabs

View in Google Earth..

. Gucan ey =
Ctrl+T
.
Ctel ~
Ctel -
Ctrl+G
Ctrl+H
Ctrl+Shift+ M
> Beta T4A Maps West and North Cape 17.05.02
> Beta T4A Maps Zambia Zimbabwe 18.05.02
> No Map

« T4A Beta Maps Full 16.10.03
T4A Maps Ethiopia Sudan Eqypt 170501
T4A Maps Lesothe 170501
T4A Maps Madagascar Mauritius 170501
T4A Maps Morocco Western Sahara 170501

Select a Product

The T4A map will now be displayed in your main window. You can zoom in and out, using the
magnifying icons in your menu, or pan around on the map, using the small hand icon in your

menu etc.

T4A Maps Mozambique Malawi 170301
T4A Maps Swaziland 170501
T4A Traveller's Africa 171001

F8 Untitled - MapSource - be
EHle Edt Find Transfer View Tools Utlities Help
T4A Traveller's Afiica 171001 ~| @& & [1500km | Medum - IR 1Y 2’ el @
i ~
Maps Waypoints Routes Tracks - e
inis
ps
Show waypoints in category GEsabldfica
All categories v et
(findouf  Adar
MName £ Symbol  Comment
Nouakehatt
Pohdngayest S N \
“BEsaly kO Qustadaiizou— Ay Djamesa . RN bouti
X Sk 0 Phrak P 8 "?D 7)
¢ TS, > s+ Garowe (Puntlond Siate Capital)
RN T )
{ o i/
T2’
AN
ar-es-Salaam
| JAstananarvo
ke Saint-Denis
‘Elp Fontein
vl itFaihs (Untata)
'%}'@ﬁjﬁﬁn'ﬂusbe\h
Tk
< > v
< >

0 lterns Selected

Go Back to Quick Guide section
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3. How to transfer T4A GPS Maps from your PC to your GPS

3AA). Uninstall any previous T4A Maps from your GPS

1. From your PC: Please access any old T4A map versions on your PC that
you are now replacing via your Control Panel - and uninstall them from
your PC!

2. From your GPS: If the new T4A GPS map that you wish to install, is on your
GPS unit, but in an older version, rather uninstall it from your GPS unit.
Steps are here below.

Please take care NOT TO uninstall your Garmap/City Navigation maps!

Since your GPS unit is now connected to your PC -
Open Maplnstall or Basecamp and initiate the Map Install function from within
Basecamp (ie. Go Maps/Install Maps). You will notice:
e Your GPS device will be picked up
e It will show the list of maps that it picked up in Basecamp that can fit onto your
GPS unit
e Click on “Customize” to continue...
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FE] Mapinstall — X
i Map

GARMIN. Please select the device you want to install maps on:

Device Settings

If you don't see your device listed below,
connect it to the computer and turn it on,
then click Find Device.

Find Device

Device: niivi 42 (Unit ID 3862866250) ~

The following maps will fit on your niivi 42 (Unit ID 3862866250).

T4A Botswana 190501

T4A Gauteng and North 190301

T4A Madagascar Mauritius 191201

T4A Maps Angola 160501

T4A Maps Free State ECape KZN 180601
T4A Maps Namibia 200302

T4A Maps Tunisia Libya 200302

T4A Traveller's Africa 200301

T4A West and North Cape 191201

T4A Zambia Zimbabwe 190601

Customize...

Now you can customize your install to your GPS unit:
e Keep your city navigation maps (garmaps) ticked so that you don’t loose them.
e Untick all T4A maps / T4A Maps to be removed.
e Then click on “Continue”
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Maplinstall _ %

The following map products can be installed to your niivi 42 (Unit ID 3862866250).

You can customize your install by checking/unchecking map products below.

—
City Navigator Southern Africa NT 2012.2
~

T4A Botswana 190501
NOT INSTALLED: 9.51 MB,

T4A Gauteng and Nerth 190301
MNOT INSTALLED: 52.7 MB.

T4A Madagascar Mauritius 101201
NOT INSTALLED: 4,52 MB

« LCanada Great.Britain:, . .
. e Morgg%:g}

P oY
T4A Maps Angola 160501 u'\g - o &
NOT INSTALLED: 9.01 MB Vehg‘eZuela “ “d
- . & 4
o - Kenva T i 1)
T4A Maps Free State ECape KZN 180601 . . X 4 nd@nesjla
NOT INSTALLED: 52.8 MB ), ¥ 0 ] L5 L
» South"Africa Australia
T4A Maps Namibia 200302 .5 - .,
NOT INSTALLED: 23,1 MB

T4A Maps Tunisia Libya 200302
NOT INSTALLED: 7.74 MB.

T4A Traveller's Africa 200201
NOT INSTALLED: 317.7 ME

T4A West and North Cape 191201
NOT INSTALLED: 25,1 MB,

<

8.08 GB free (67.5 MB used)

Advanced/Partial Install...

Take note of the message here - you will install some (ie. your city navigation) and delete
some (ie. the T4A maps). You will notice which maps will be:

e |Installed

e Removed

Click on “Install” to continue. This will remove the maps you have unticked.
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Maplnstall _ w
Installing to niivi 42 (Unit ID 3862866250):

This will install maps on your device and delete some old ones. It could take hours. Are you sure?
~

Alnstalled Maps:
\

-1

City Navigator Southern Africa NT 2013.3

IRemoved Maps:
T4A Botswana 190501

< Back Install

When the installation is done, you will see this screen, click on “Finish”.

Maplnstall

GARMIN.

Completing the installation of maps to your GPS.

o G

If you switch your GPS unit on now - go to your Map Info: you will notice only the maps
that you did not remove in the “uninstallation process” are still there.
There are no T4A Maps - as they have been uninstalled.
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& CN Southern Africa NT 2013.30

3A). Detailed Steps: Using Maplnstall to transfer T4A Maps to your
GPS

Open Maplnstall by launching it from your “Start” menu. (ie. if it is not listed in your Start menu,
do a search on your PC for it).

B 0 @
P ot match

Maplnstall
- B pesktop app

P Ml 4D Tw07/223

Please note that the Maplnstall function is located within Basecamp as well - so you can access
this functionality from within Basecamp, or you can open Maplnstall directly on your PC.

When transferring map/s to your GPS unit, Maplinstall should be open and your
GPS system switched on and plugged in.
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Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be
erased from the GPS, especially your Garmap Street maps. If your Garmap maps are on
your SD card, transfer your T4A maps to the internal memory of your device and vice
versa.

Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from your

internal memory or SD Card on your GPS unit and from your PC, otherwise the new T4A
file will not be transferred. (See steps here)

Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card
slots (ie. one for the camera and one for maps):
e Be sure to remove the camera memory card to ensure that Maplnstall will only see the
Map Memory card, so that the maps can be loaded onto the correct memory card in the
memory card slots.

When Maplnstall opens up, it should automatically list your GPS that is connected to your
computer. If not, search for it in the dropdown list next to “Device”.

Please select the device youw want to install maps en: |

GARMIN.

Devue Settings

EF you don't see vour deace ksted below,
conrect it to e computer and b it on,
then dhok Fired Dewice.

Fird Dervice

Devce:  DrivedAssist 50 (Unit [0 393258 ~

The folowiig maps will it on your Drivelesst 50 [Und [0 PRS0 T)

Tk, Troveler's Afrca 171001

If there is an SD card in the GPS unit, you will notice that MaplInstall lists your Device name and
the words “+SD Card” - see below. (ie. this means that the T4A maps will be installed on the SD
card).
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Flease select the device you want to install maps on:
GARMIM.

Dvice Setbngs

LF yous dlon’t see your desvice ksfnd below,
eonnect it io Bhe computer and tuen it on,
then chok Find Dervice.

Fird Denvice

Dervice: |:-wmmmum e

“The following mans vl fit on your Deivessst 50 (Lt 1D Y932587601).
T4 Traveler's Africa 171001

Then click “Customize” in the right bottom corner.

Then select the maps you wish to transfer to your GPS. Then click on “Continue”.

The following map products can be installed to your DreveAssist 50 (Unit 1D 3932587601 ).

You can customize your mstall by checking/unchecking map products below.

M Southerm Africa NT JOIL 10
BLAEADY IRETRLLED S 148 W

T4A Traveler's Africa 171001
WILL INSTALLL 2931 MB.

7.91 GB free (509.5 M8 used)
&=
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Then click on “Install” in order to install the maps to your GPS unit.

Installing to DriveAssist 50 (Uit ID 3932587601 ):

This will mstall maps on your device. 1t could take bours. Are you sure?

Installed Maps:

CN Southem Africa NT 2018.10
T4A Traveler's Africa 171001

Maplnstall will then continue with the installation process.
When the installer has completed, click “Finish”.

T8 mhapinstall

GARMIN.

Comgpletng the mstallabon of maps & your GPS.

Serwding maps o TriveAssst 50 (Uit ID 3932587601)"

TN compizte, 2 minutes remareng

& ok [.SNI
You are done - your gps maps should be installed on your GPS unit.

Go Back to Quick Guide section
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3B). Detailed Steps: Using BaseCamp to transfer T4A Maps to your
GPS

Open BaseCamp.

When transferring map/s to your GPS unit, Basecamp should be open and your
GPS system switched on and plugged in.

Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be
erased from the GPS, especially your Garmap Street maps. If your Garmap maps are on
your SD card, transfer your T4A maps to the internal memory of your device and vice
versa.

Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from your
internal memory or SD Card on your GPS unit and from your PC, otherwise the new T4A
file will not be transferred. (See steps here)

Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card
slots (ie. one for the camera and one for maps):
e Be sure to remove the camera memory card to ensure that Maplnstall will only see the
Map Memory card, so that the maps can be loaded onto the correct memory card in the
memory card slots.

In BaseCamp, click on the menu item Maps > Install Maps: (ie. this is the Maplnstall feature
incorporated within BaseCamp)
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@ Garmin BaseCamp
File Edit Device Find View Tools | Maps | Trip Planner Adventures BirdsEye Signin  Help

Search - E

o Beta T4A Maps West and North Cape 17.05.02
f BB X9 o ([0 4
- Global Ma|
@) BaseCamp found some new tracks on your niivi 42 7 3 %
o TAABeta Maps Full 16.10.03 - . ,
Library ~ "
4 Libran T4A Maps Ethiopia Sudan Egypt 170501 -
Sy calster T4A Maps Lesotho 170501 3
- Dtz received from nivi 42 (Unit | A== b4 F 2
") oe-Mar18 53230 A T4A Maps Madagascar Mauritius 170501 .
@ 100412013 3:21:09 PM T4A Maps Morocco Western Sahara 170501 @ *
=[F LEC Files submitied to Warchouse T4A Maps Mozambique Malawi 170501 ‘hemotsoans] o Ha Seshote [(E[”‘m,‘” Fenge BstOfhere ~ @uE Low Range Wes{ Of Here
1L »”
[) LEC NEWPOINTS_Regian_. T4A Maps Swaziland 170501 % 3, 3 g
[] LEC NEWPOINTS_Region_ T4A Traveller's Africa 171001 [uHa Koselabolk A i 5wt G M
- [2] LEC NEWPOINTS_Region_. . N -V‘"Eg_e 8 @’?
[5) LEC NEWPOINTS Region_ ‘ 0 M: "
5tz
- [2) LEC NEWPOINTS_Region_ Z=EllLls
[2] LEC NEWFOINTS Region_.. Manage Map Products... : «Malingoaneng
=S m ] L Use Low Range South Of Here '
Manage Custom POls...
LEC NEW POINTS_WEST_NORTH_Cape.g.. *J ‘ 2

. irstrip”
s~ Vilage @EA

. Lehlabaneng

Closed (Engen Fuel Stop (Doring Bay))
Engen Fuel Stop (George)

Fuel Stop (Kakamas)

Total Fuel Stop (Nessab) (07:20-12:00)

[ ctosed (Miller's Restaurant)

%
"b% ) AwdRequiredGray

.
.Ha Seknhehola . Makhuleng

[ crosed (Sandwich Baron Restaurant - St
(1] Fish-2ways ' S=Sevee Pot Holes Ard Ruts.
Stears Fish-Aways (Oudtshoorn)

= Amani Boutique Hotel

emina SchoglShau Rivar Brdge,

L nBees

Amazian Lodge

& Amble Inn Guest House

® Amritz Private Lodge & B&B

v
Search EE2

Show Overays  ~

B S oA P BEFO @ K ) o

US  06-Mar-18 Ez

You will notice that this then initiates the MaplInstall function. Please follow the following steps
on the screens to complete this process:

File Edit Device Find View Tools Maps TripPlanner Adventures BirdsEye Signln  Help

LaX(9 ik ([Qe A% O0% B - ¢

) BaseCamp found some new tracks on your niivi 42 . Click here for aptions

@] Maplnstall - X

Search -B

4 Library A
[ My Collection
&P Date received from niwvi 42 (Unit L {
[2) 06-Mar-18.9:32:30 am \ GARMIN.
[B) 1042013 3:21:09 P18 /
- [F LEC Files submitted to Warehouse:
[8) LEC NEWPOINTS_Region_
- [8) LEC NEWPOINTS_Region_
- [B] LEC NEWPOINTS_Region_
. @ LEC NEW POINTS_Region_
@ LEC NEW POINTS_Region_
@ LEC NEW POINTS_Regicn_
= S .

Please select the device you want to install maps on:

Device Settings

If you do't see your device listed below, F[]eton erseiestoftiare
connect t to the computer and turnit on, 2

n click Find Device.

=55t Manens Church

Find Device

Semenany;
5
%,
S

ity

Device:

- Malingoaneng
r—_,uQ Low Range South Of Hers '
st

LEC NEW POINTS_WEST_NORTH_Cape.g... .}

Closed (Engen Fuel Siop (Doring Bay))
Engen Fuel Siop (George)

Fuel Stop (Kakamas)

Total Fuel Stop (Nossob) (07:30-18:00)

(£ Crosed illers Restaurant)

Closed (Sandwich Baren Restaurant - St
[ Fist-avays

Stcers Fish-Aways (Qudtshoom)

* Amani Boutique Hotel

. Lehlabaneng

AwdRequired]Gray|

\uleng

Jangnpaes

® Amazian Lodge

= Amble Inn Guest House Continue

® Amritz Private Lodge & B&B

v
Search [EE2

529° 26.152" E28° 44.821"

Show Overays v

Your Device name will then pop up in the Device list, and in the bottom window a list of all the
possible maps that can be transferred and that will fit onto your GPS unit is displayed.
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e |f your device is not listed under the “Device” drop down list, then click on “Find Device”
in order to allow your PC to read and recognise your connect GPS unit. (ie. if your GPS
unit is not connect to your PC, then it will not appear in this drop down list).

e Under “Device” you can choose to send the T4A GPS maps to your GPS units’ internal
memory, or to the SD card (if you have one inserted into your GPS) which will be listed

as “Removable Media” or “Removable Disk” etc. (Note: heed warning at beginning of this
section in red about taking care not to overwrite Garmap or other maps already on your GPS).

gg.
File Edit Device Find View Tools Maps TripPlanner Adventures Birdsfye Signln  Help

Search - B
tamX 9t b (Q¢ AR%S Oe% B Y- ¢

) BaseCamp found some new tracks on your niivi 42 . Click hers for options "%
4 Library ) [ Mapinstall - x

=My Collection

©]7=) Data received from nivi 42 (Uit |

[ Please select the device you want to install maps on:
- [2) 06-Mar-18.9:32:30 AM M GARMIN.
[2) 10201332109 PM 4

£+ [F=LEC Files submitted to Warehouse
- [E] LEC NEWPOINTS_Region_.
@ LEC NEWPOINTS_Region_
- [2] LEC NEWPOINTS_Region_
[] LEC NEWPOINTS_Region_..
- [E] LEC NEWPOINTS Region_
e vromrs e

Device Settings

If you don't see your device listed below,
connect it to the computer and turn it on,
then diick Find Device.

Device: |nivi 42 (Unit ID 3862866250)

Semenanyane

Malingoaneng
.

,’@Uﬁ Low Range South Of Here

LEC NEW POINTS_WEST_NORTH_Capeg.. strip
= Le
Closed (Engen Fuel Stop (Doring Bay))  # |, The falloning maps wil it on your niivi 42 (Unit ID 3862866250). =

Engen Fuel Stop (George)
Fuel Stop (Kakamas)
Total Fuel Stop (Nessab) (07-20-18:00)

Beta T4A Maps West and North Cape 17.05.02
T44 Beta Mags Full 16.10.03 ? AwdRequired[Groy
T4A Maps Ethiopia Sudan Egypt 170501
T4A Maps Lesotho 170501

T4A Maps Madagascar Mauritus 170501 wleng
T44 Maps Morocco Western Sahara 170501
T4A Maps Mozambique Malawi 170501

T4 Maps Swaziand 170501

T4a Traveller's Affica 171001

[ ctosed (Miller's Restaurant)

IEJ Ctosed (Sandvich Baron Restaurant - St
Fish-fways

Steers Fish-fways (Dudishoor)

 Amani Boutique Hotel

LarEnBeas

Customize...
= Amazian Lodge

® Amble Inn Guest House ;. Continue |

® Amritz Private Lodge & B&B

v
Search [EE3

Show Ovedays  ~

If there are multiple maps that appear in your list and you only want to send specific map/s to
your GPS, then click on “Customize”. The following screen will appear where you can
customize which maps you want to send by ticking the checkbox:
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) Maplnstall =

The following map prod can bei lled to your niivi 42 (Unit ID 3862866250).

You can customize your install by checking/unchecking map pi below.

Navigator Southern Africa NT 2013.3 !
ALREADY INSTALLED: £7.5 MB A |

T4A Traveller's Africa 171001
WILL UNINSTALL: 177.6 MB

Beta T4A Maps West and North Cape 17.05.02
NOT INSTALLED: 32.9 MB

T4A Beta Maps Full 16.10.03
MNOT INSTALLED: 255.3 MB

T4A Maps Ethiopia Sudan Egypt 170501
WILL INSTALL: 16.5 MB

T4A Maps Lesotho 170501
NOT INSTALLED: 906 KB

T4A Maps Madagascar Mauritius 170501
NOT INSTALLED: 4.41 MB

2.01 GB free (84.1 MB used)

. 1ehran .rf@i
Afghani:
fiwai Pa

ki

Advanced/Partial Install... | . I I I I I I I

T

If you click “Continue”, Maplnstall will show you what it is going to install, uninstall etc. on your

GPS unit, for example:

Maplnstall n

Installing to niivi 42 (Unit ID 3862866250):

This will install maps on your device and delete some old ones. It could take hours. Are you sure?

Installed Maps:

City Navigator Southemn Africa NT 2013.3
T4A Maps Ethiopia Sudan Egypt 170501
Removed Maps:

T4A Traveller's Africa 171001 (Partial)

< Back

Install

Click on “Install” to start the process. This screen will typically appear:
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Maplnstall = x

GARMIN.

Completing the installation of maps to your GPS.

Sending maps to "nivi 42 (Unit ID 3862866250)"

Transferring map set...

24% complete

=

< Back Finish
When completed, you can click on “finish” in this screen:
-Maplﬂsta\l = X g

GARMIN.

Completing the installation of maps to your GPS.

Maps transferred to "niivi 42 {Unit ID 3862866250)"

The data was successfully sent.

1

Go Back to Quick Guide section

3C). Detailed Steps: Using MapSource to transfer T4A Maps to your
GPS

IMPORTANT TO NOTE: MapSource allows you to view the T4A GPS maps, plan trips etc.
MapSource can only transfer & receive maps, waypoints etc. to and from a GPS unit for T4A
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GPS Maps version 18.05 and older...The latest T4A GPS maps cannot be transferred
to/from a GPS unit with Mapsource.

Therefore, if you have T4A GPS Maps version 18.05 or older then:

Open MapSource.

When transferring map/s to your GPS unit, MapSource should be open and your
GPS system switched on and plugged in.

Each time a mapset is sent to a Garmin GPS, the previously loaded maps could be
erased from the GPS, especially your Garmap Street maps. If your Garmap maps are on
your SD card, transfer your T4A maps to the internal memory of your device and vice
versa.

Note: Previous T4A Maps, that you are now replacing, must be UNinstalled from your
internal memory or SD Card on your GPS unit and from your PC, otherwise the new T4A
file will not be transferred. (See steps here)

Also Note: If your GPS unit (eg. the Garmin NuviCam LMTHD range) has 2 memory card
slots (ie. one for the camera and one for maps):
e Be sure to remove the camera memory card to ensure that MapSource will only see the
Map Memory card, so that the maps can be loaded onto the correct memory card in the
memory card slots.

1: In MapSource, go to View > Switch to product and select the mapset you wish to transfer.
The map will be visible in front of you. If not, use the zoom button to zoom in or out to find the
map on your screen. (ie. a previous step explains how to view and access the maps in

MapSource)

2: Go to Tools (at the top of the toolbar) and select ‘Map’. The Map tool is used to select the
map/s you want to transfer to your GPS unit.
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8 Untitled - MapSource -
File Edit Find Transfer View Tools | Utilities Help

T4A Travellers Afiica 171001 Map m Medium H&E | XD el o m
~ Zoom z
Maps Waypoints Reutes Tracks Hand h
. ,g IENWJ””‘S
i oY
Show waypoints in category: Waypoint w Cﬂ;ah‘\é“’vpa =
Al Categories Route r -ﬁ;m Bechar
———— Selection s
Name 7
Distance/Bearing d
Track Draw t § " /
Track Erase e Nauakchott
Track Point Select p Dk, gayes
Track Join j ‘o Bissal
.
Track Divide c b
B *.,;\Annmwa .. V_ Enu
m.‘eem-ﬁma\ R
:
*ote flore
et ar-25-Salzam
p T’Pf . |tananaivo
& :”" B”am‘*“ -y Saint Denis
I N ‘>:{:z‘}ar\een e
/3% ofoha "Eshurg (o
ihatha {Umtata)
é%ﬂlsnvelf«ﬁn Bizabeth
150
< >
<
Select the Map Tool

That will initiate the “Polygon” Map Tool icon - visible on your cursor:

g

The T4A map is divided into 16 regions - depending on which map your purchased from T4A,

you will notice the map light up in yellow as you hover your mouse over the different map
regions. (ie. in this example below, the entire map was purchased, which includes all 16
regions)

B8 Untitled - MapSource - X
File Edit Find Trensfer View Tools Utiliies Help
T4A Traveller's Afica 171001 V| @ @ [1500km | Medum & & 2 QM fFul =
‘ ~
Maps  Waypoints Routes Tracks =
unis
otah gg“ﬂgm.‘, iy
Show waypoints in categary: Gasemai;a ¢ T
Al Categories - A JBechar R( g "pa\m
2+ fndodt pdar \.
Neme Symbol | Comment - .
¥ \. . .
¥ 3
\ / ot Suden
Nouakchott .
¥ Qiu_) \Agadez )/
s {’\:mara
Ly Emk‘?_g“agadauaau" \wmamena . ' ?ﬂbm
% 1
. --/'7Gamwe (Putiand State Captal)
Deres-Sazam
j‘manananvu
Saint-Denis
dess '*,_Elgenimem
Tl “Nihatna (Umiata)
Y Bizzbeth
13000
< > v
< >

0 ltems Selected _ Lat/Lon hddd*mm.mmm'(WGS 84) 5924258 E3112.070  Tdazambiazimbabwel 71001, Traveller's Africa, 18.1 MB
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When you click on the map with the Maptool, the map will turn pink (see
example below). If not, zoom in to the map in order to see the selected pin map area.

B8 Untitled - MapSource
File Edit Find Teansfer View Tools Uilities Help

T4A Travelers Africa 171001 v| @& & [1500km | Medum v ETRETY 2o el =
.
Maps(1) Waypoints Routes Tracks o
s
sian g“ﬁwem!w Fax
Show waypointsin category: ey Tt
Al Categories v S ﬁ{/ : pam
o+ ffindout pder
Name Symbol  Comment
\
‘-N ey /7 Poit Sudan
grouane Gao | eadez f
Pekar, ayes ¢ R
> o N
gy fono et Apraned Sibout
) 3aughi, i b b
%ﬁ ! gqfﬂ'ﬂk: th /ﬁ{s i 4wt Gafowe (Purtisnd State Captal)
urvru!\a‘ 5y Frpo e
S A ) 07
y}ﬁﬁ]ﬂéng‘, e |y
g.n:Te s ) 3
R otia )24
7o
:gu@eﬁmm
o2k res-Salaam
{ Jdtananaivo
‘Saint-Deris
o0t
< > v
= >

0 Items Selected  Lat/Lon hddd®mm.mmm'(WGS 84) 5955808 £3117.343  T4azambiazimbabwel71001, Traveller's Africa, 18.1 MB
EN\

@FELEam z0E

B8 Untitled - MapSource
Fle Edit Find Transfer View Tools Utiities Help

TéA Traveller's Africa 171001 v @ & [300km  v| | Medum v H& 2 Q]E p Q ==}
i SN NN Tk ) Jing
Maps(1) Waypoints Routes Tracks J Massahgo \ \
\ Lucapa)! | Kepanga
e [ ¥ £ gy N
Show waypeintsin category: Whtra A Suliohs A (C
Al Categories v e | i} Saumo {1 \Sardoa A ’
s ghéoa”) /) L ] -
Name £ Symbol  Comment Mlssende biim
Gabela R g
Sumbe Calnmi A \ (PN %,
“Anigols . = P v
Camacupa X g/
AobioCtingongo i . ‘jf“""”é;”e”‘ ¥
& v
i { 95 Femba
chinga
Caconda F pate
+ 7 Liongne
1 / 7 Yacala
Lihngasadls Merionaue VA Ciiamba N
ﬂam\be 2 ) . Jampuiz
o e R
Sbuth West Angoia 5 Jetd [J
‘ \ BTy \ NN
| 7 I 3
P e o W Kawna wid]  FOL o \oren (7 / -
Kaskoland SR \_‘M&“/~ '/“/ T toia FAsttN R i Qusiffins
A N e C e /
Elosha. | I\ dare
Teurreh 3 Huntérs Road A
Siav 3 i\ { N
3 § e ¢ , Beie
Skeleton Coast - Ol S fongaeers]
Dafmarclaid { . <Y
Ghanzi i ), .
rics B s eles. Tikike 7 ancuios
& Wik Gobabh E ) Wuseis (Paana) ¥
Wahig Bay P a Makhado\(Lowis Trehard)  indian Ocean i
(Rehabith \ A~ i I o
< L S Fa SN . VLAMCLES, | T . v
< >

0 ftems Selected _ Lat/Lon hddd® mm.mmm'(WGS 84) 515 25112 E26 24.735__ Tdazambiazimbabwe171001. Traveller's Africa, 18.1 MB
~

ENG  %57AM
2D B 4 e e

If you want to transfer more than one map to your GPS system, repeat step 1

and 2 above, by selecting the map(s) you want to transfer to your GPS unit..

If you’ve purchased the Full Map Set and you want to transfer the full set, please make
sure that the 16 map sets is selected before transferring the maps.

If you only want to transfer a few of the map tiles only, then select only those

you want to transfer for example Namibia, Botswana or East Africa.

3. To transfer the map/s to your GPS, select Transfer on the toolbar, and then
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Select “Send To Device”.

P8 Untitled - MapSource
File Edit Find | Trensfer View Tools Utilities Help

T4A Travelier's A Send To Device.. W0km v | |Medium H&| Q3 L @
————————  ReceiveFrom Device - -
‘ S dee A ] {1 Jhzagi] o /! 5 | ) Jingapi]
Maps(1) Waypoints Routes Tracks \ . /| Massshgo | e AV S / . v
y | 1 Lucapa)| | Kapanga - " )
. P dA KOO B LTS ) e .
Show waypaints in category: NDalatends ] ITRITi S kema i i A
All Categories ~ -~ A N i | Sauimo | 1) \Sandoa) 3 [ & X ¢ ! i
. S AT WL i o e Nk W -
Name ¢ Symbol  Comment il ide I f Divum 3 + O N\
| Gabela . o ) —73
Sumbe | s (= : \ ~ 4
Anigola, g Y A A L .
\lsbitoChingongo : A ‘Emhané;’e”' ol
o Canaa e T Elawi / L f .
~ andat | emba
v LI\ B Jichinga e 1
"aconda| | Shpata /
2 /\' Liongie \ \ ~
0\ Mstala (o N : - ! 7 <Y O .y /77 Nacala
Libango? 1 P e 4
Nairibe 7 L AN ) , I pampuiad
J s — A \ [ on AN
Seith West Angola™~ | S . A Tetd fJ . =Y,
adl) SRR WA ~ N e 3 i 77 £ ) P
. Kaokoland Oshakati \,‘W"/\/&"\ horia E y A 10 Queimane
\ i Etosha’; § | o dive W Mlkare ()
% 1\ Jouries ° . untér’s Ro N\ g 5 ’? . p
< Ofag N j Ny A R
” ; U V- Maun. = b Eeira
Skeleton Coast - \ £ ]
P R T | Wkgedicgadi, ~ b 7| | Fomngebol
Damaraland Il _ 1 { " { AOVN S '
i A Ghanzi J . }?ﬁck’ { -
% Herties Bay ta) ~ — A -4 flanculos
J’f oL Winglock Gobabls” \ S=usina (Messina) A
abis Bay' > TN 77 ] Meico\louss Tacbd) indap Bean i
Q 5 - Voo Limbopo
S ZamBR S =N a3 SRR N LN - Iv
< >

Transfer the data in the active document to your device
ENG 10:01 AM

Us  22-Mar-18 53

The “Send To Device” pop up screen will appear:

e |[f your device is not listed under the “Device” drop down list, then click on “Find Device”
in order to allow your PC to read and recognise your connect GPS unit. (ie. if your GPS
unit is not connect to your PC, then it will not appear in this drop down list).

e Under “Device” you can choose to send the T4A GPS maps to your GPS units’ internal
memory, or to the SD card (if you have one inserted into your GPS) which will be listed

as “Removable Media” or “Removable Disk’ etc. (Note: heed warning at beginning of this
section in red about taking care not to overwrite Garmap or other maps already on your GPS).

e Ensure “Maps” is ticked, as this is what you want to send to your GPS.
e Then click “Send” to transfer the maps to your device.
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s
File Edit Find Transfer View Tools Utilities Help

T4A Traveller's Afiica 171001

o] & & [300km | [Medum ~ ETRET

.
Maps(1) Waypoints Routes Tracks

Show waypoints in category:
All Categaries v

Name 7 Symbol  Comment

Lat/Lon hddd*mm.mmm'(WGS 84)

Y W o
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7 : by \'I?“FE nga
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U
9

. 3‘3‘?”'1‘\':- connect it to the computer and turn it on,
then dick Find Device.

™ loaconds)|

Find Device

h ‘ Device: |nivi 42 (Unit ID 3862866250)
| nijvi 42 (Unit 1D 3362866250
\ihat To {Removable Media (6:

[Maps Routes
“ oy Waypoints Tracks
| Kackoland o Oshakl 11 Guglimane
N o 1 l\ﬁ E 3
| Hlosha s - s Mitare 9
O Nrme 7 P~ P Fint&sHoad e 1 g
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h o T il RS /r""vlmana_(yl ssmfa_);::l e
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i/ 75 RSN, {Rarhana v
>

ENG 10:03 AM

5 2Mantt N

When completed, the T4A GPS Maps will now be available on your GPS unit.

Go Back to Quick Guide section

4. DON'T FORGET TO:

4A). Register your SD Card

In order for us to provide you with a free upgrade and subsequent discounts, you need to
register your SD card on our site. (Please refer to the section further below titled “Read about our SD
Card GPS Map Releases & Free Upgrades” for more information on free upgrades).

e If you purchased your SD card online from us: please check as follows if your SD
card is registered: On our online shop, login in:
o Go to “My Account’

Orders

e View the Order for the SD Card purchase (The SD Card Serial
Number & Product Code will be visible there).

e If you purchased your SD card from a retailer: you need to register your SD card on
our online store. See steps further below.
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If you require any assistance in this regard contact us at sales@ftracks4africa.co.za

Steps on how to register your SD Card:

Have your SD Card packaging handy

Serial Number is on the outside,
on the back of the SD card packaging.

3 Mac users ane also included on the SO card. If your GPS does

computer to your

Prt'.nductKeynr No. is on he
inside of the packaging.

Registering your card on our online shop

You can register your SD card here on our online shop:
Go to Shop>GPS Maps (SD Cards)>Register an SD Card
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~ks4Africa

Paper Mags

GPS Maps [Downlaodabde )

Register an SD Card

Registering your 50 card entitles you to one free upgrade to the next release of aur

available as a link to the downloadable magp file on your pg

Bought vour 5D cand Bought vour SD card Whyv St

©pprright TRACK4%FRICA
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The link to register 8D Cards
is found here on the menu.

Either Scroll down or
click on register an SD
card to get to the 5D
card details capture
form.

ould [ register
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SD CARD REGISTRATION =~~~ - e
e

Tracxafarmca H o= te  EA " W ; & Q

Register your SD Card by completing the form

First Hame * Capture the SD card
registration information

~ here. You only need to

[rrI— o " capture this basic info.

Sorlal Number

| 1 The Serial Number
lanine@tracks4af ) (outside of packaging) and
| the Product Key (inside of
/ packaging ) must be
-1 entered here.
£

Product Key *

2. When done, tick to accept
| the terms and conditions, and
__ click on Register.

BhET 8N
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SD CARD REGISTRATION =~ - .ce-
e A

P The"i: ustc-mers . . ®

- | sD Card will
have a status of b, sl el AT o 8 casdde
\__ REGISTERED -~ _ | retailers? :

our SD Why Should | register

. on the T4A J/| s already heen ) - Vousll receive one free upgrad
- database. , T it sl pienmese L On successful
ST registration the
35 - customer will get
E - . this message:

) B= &p P ®

Help with registering your SD Card

Please contact us at sales@tracks4africa.co.za with your request, and please provide:
1. Your name and surname
2. Email address
3. SD Card Serial Number (on outside of packaging)
4. SD Card Product Key / No (on inside of packaging)

4B) Read about our SD Card GPS Map Releases & Free Upgrades

When you purchase an SD Card it entitles you to 1 free upgrade on the following version only, and
then further 50% discount purchases on any other subsequent versions of SD Card / Subscriptions for
a complete set of Downloadable GPS Maps.

Note: Tracks4Africa can only offer you a free upgrade etc. if your purchase is registered on our
system: Please refer to the section in this document titled “Register your SD Card”.

At Tracks4Africa, we officially update our GPS maps on SD Card for Garmin units twice a year,
every May and October:

e Our 2023 May release version will be named “23.05” (ie. 2023 May month release)
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e Our 2023 October release version will be named “23.10” (ie. 2023 October month release)

You will be notified via email, when a new release is available, which will contain a link to our online
store checkout, where you will have a 90% OR 100% free coupon to claim:
e On SD Card couriered to you with a 90% free coupon (ie. Note the remaining 10% is for
us to recover our cost of the actual SD card and you will pay the courier costs)
OR
e Via a Download link with a 100% free coupon (ie. You will be emailed a zipped file
containing the full set of T4A GPS Maps in an .exe file)

For more information please refer to this page on our shop.

Go Back to Quick Guide section

4C) Check out the T4A Africa Guide on your GPS

The Africa Guide is a digital file that is included on the T4A GPS Maps SD Card. It contains information,
where available, on the POls (Points of Interests eg. Lodge, Campsite, Restaurant etc.) that are on our
GPS Maps.

This Africa Guide can be accessed under "Extras" on your compatible Garmin Device.

This Africa Guide enables you to look up descriptions, contact details, rates, facilities and activities on
offer for lodges and campsites in Africa directly on your GPS. Also included are searchable picnic
sites and border control information, perfect for your next road trip.

and chean ablution blocks and campers
i b0 b gt sulficient. + 264(0)64 403
429

+264(0064 203 581
accounts@rhino-trust, org.na

FROM 45 TO 45 NAD PR, **RAY IN: Cash.

===FACILUTIES: Swimming, *=CAMPING
FACILITIES: 8 Sites, Hot Cold Water,
== ACTIVITIES: WD Trails, Game

Drives.Game Viewing, Guided
Walks. Swimming,Night Drives,
whifd

You can also look up information on various attractions (eg. wine farms) and activities (eg. 4WD-trail)
that exist as Points of Interests (POI) on our maps.

Note: we no longer publish photos on this guide, as it increases the size of the guide tremendously, and
will then take up to much space on a GPS unit.
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See the category "Communications": use this to find the nearest point selling airtime, offering internet
access, or wireless, or where the nearest public phone is, or a good mobile reception spot.

Also see our "Shopping" category: to help you find your nearest shop of choice, and the nearest place
selling gas.

For more information on this guide, please have a look on our website here.

Go Back to Quick Guide section
OR

Go Back to New Extras Data Found on Card message
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